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Support

Please visit the HP OpenView web site at:

http://www.managementsoftware.hp.com/ 

This web site provides contact information and details about the products, services, and support that HP 
OpenView offers.

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valuable 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many also require a 
support contract. 

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:

https://managementsoftware.hp.com/passport-registration.html
3



4



Contents
1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Change and Incident Data for Compliance Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Supported Service Desk Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Package Version History . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Sources for Additional Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2 Package Installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Guidelines for a Smooth Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Installing the CM Service Desk Datapipe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Confirming Data Collection Readiness . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Verifying Successful Collection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Removing the Datapipe and Dropping Views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

3 Datapipe Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Your Compliance Manager Data Model Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Service Desk Data Structures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Assigning SD Data Structures to CM Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

4 Extending the Datapipe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Adding a New Metric to the Datapipe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Data Flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
 1



2



1 Overview
Compliance Manager applies a template to your environment. The template is a structure 
consisting of high-level processes, the applications that support those processes, component 
groups within each application, and components within each group. At the lowest level of the 
structure, the component level, Compliance Manager enforces tolerances for availability, 
incidents, and changes. At each higher level in the structure, Compliance Manager aggregates 
risk and control violations detected at the component level.

By rolling up risk and control violations from the lowest level in the model to the highest 
level, the Compliance Manager Report Pack lets you see which business processes, if any, are 
not compliant with tolerances. You can see how many violations occurred and you can also 
drill down to see which supporting applications, or which instances of those applications, are 
responsible for the threshold conditions.

Compliance Manager 1.0 assesses risk and the adequacy of controls by processing data 
collected from the following metric areas:

• Availability

• Incident management

• Change management

The next release of Compliance Manager will have a broader perspective on risk and control 
measures. The following metric areas will be added:

• Information security management

• Release management

• Configuration management

Change and Incident Data for Compliance Manager

The Compliance Manager Service Desk Datapipe is a combination of tables and processing 
routines. The processing routines move data from Service Desk installations to tables 
maintained by the datapipe, and from tables maintained by the datapipe to additional tables 
maintained by the Compliance Manager Report Pack. The CM Service Desk Datapipe is an 
optional datapipe for the Compliance Manager Report Pack. Install the Compliance Manager 
Report Pack first, create your Compliance Manager data model, then install the CM Service 
Desk Datapipe.

In addition to providing scripts that move data to the Compliance Manager Report Pack for 
further processing, the CM Service Desk Datapipe provides a form and a report for managing 
the data connection. The report and the form deploy automatically when you install the 
datapipe. Use the Service Desk Data Model Assignment form to assign Service Desk data 
structures (with associated change and incident data) to a Compliance Manager component. 
Use the linkage report to identify the Service or Configuration Item (CI) in the Service Desk 
database and then launch a Service Desk user interface pre-filtered for that item.
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The CM Service Desk Datapipe collects data from Service Desk once a day, at 4.00 a.m. The 
collection captures Changes and Incidents that took place within the previous two full days, 
including up to the time of the collection. The size of the capture window guarantees that even 
an outage of connectivity between OVPI and Service Desk that lasts a full day will not result 
in lost data. If needed, the capture window can be modified by extending the Time Period of 
the reports used during the extraction.

Supported Service Desk Configurations

Service Desk has various configuration options. The following items are configurable:

• Number of service levels

• Number of configuration-item (CI) levels

• Do not distinguish major incidents; recognize incidents only

• Distinguish major incidents; recognize major incidents and incidents

Compliance Manager has the following requirements for configuring Service Desk:

• No more than four service levels (less than four is okay)

• No more than three CI levels (less than three is okay)

• Must recognize major incidents as well as non-major incidents

• No constraint on the number of incidents

• An incident can map to a CI at any level

The following diagram shows these conditions in effect:

Business Process

Application

Application Instance

Application Instance 
Component Group

Application Instance 
Component

Service 1

Service 2

Service 3

Service 4

CI 1.1

CI 1.2

CI 1.3

CI 4.1

CI 4.2

Incident CI 1.1__1

Incident CI 1.1__2

Incident CI 4.1__1

Incident CI 4.2__2

Incident CI 1.3__2

User defined 
relationship 
between SD 

side 
services and 

CM side 
data model.
Accessed by 

a form.
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Package Version History

The following table outlines recent enhancements to the CM Service Desk Datapipe.

Sources for Additional Information

The following documents are related to this manual:

• Compliance Manager Service Desk Datapipe 1.0 Release Notes, December 2005

• Compliance Manager Report Pack 1.0 User Guide, March 2006

• Compliance Manager Report Pack 1.0 Release Notes, December 2005

• Service Desk Reporting Solution User Guide, May 2006

Except for the Service Desk Reporting Solution User Guide, the manuals listed above are 
located in the Docs directories under each package on the Compliance Manager CD. The 
same manuals can also be downloaded from the following site:

http://www.managementsoftware.hp.com

Select Support > Product Manuals to reach the Product Manuals Search page. The user guides for 
OVPI are listed under Performance Insight. The user guides for report packs and datapipes are 
listed under Performance Insight Reporting Solutions. 

The manuals listed under Performance Insight Reporting Solutions indicate the month and year 
the manual was issued. If a manual is revised and reposted, the date of issue will change. 
Since revised manuals are posted on a regular basis, we recommend searching this site for 
updates before using any of the manuals you can find in the Docs directory on the Compliance 
Manager CD.

Version Release Date Features/Enhancements

1.0 March 2006 Initial release; includes:
• Service Desk Data Model Assignment form
• CM to SD Data Linkage report
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2 Package Installation
This chapter covers the following topics:

• Guidelines for a smooth installation

— Contents of the Compliance Manager CD

— Software requirements

— Configuring the Service Desk system as an External Reference Database

— Installing integration views on Service Desk

• Installing the CM SvcDsk Datapipe

• Confirming data collection readiness; verifying successful data collection

• Uninstalling the CM SvcDsk Datapipe and dropping views

Guidelines for a Smooth Installation

The Compliance Manager product CD, released March 2006, contains all the packages you 
need to implement Compliance Manager. When you insert the CD and launch the package 
extraction program, the install script on the CD extracts packages to the Packages directory 
on your system. When the extract finishes, the install script launches Performance Insight 
and starts the install wizard, Package Manager.

If the packages on the Compliance Manager CD have not been extracted, your first task is to 
extract packages from the CD and install the Compliance Manager Report Pack. If the 
Compliance Manager Report Pack is already installed, your only remaining task is to install 
the CM Service Desk Datapipe by starting Package Manager and following the familiar 
on-screen instructions. Before installing any software, be familiar with the contents of the 
Compliance Manager CD and know the datapipe’s software requirements.

Contents of the Compliance Manager CD

The Compliance Manager CD includes the CM SvcDsk Datapipe and many other packages. 
The following table provides a list of the directories inside each package. 

Package Directories

Compliance Manager ComplianceManager.ap
ComplianceManager_Demo.ap
ComplianceManager_Thresholds.ap
Docs
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The Docs directory contains user guides and release notes. Before using any document in any 
of the Docs directories, check for updates on the web by going to openview support > product manuals 
> product manuals search. Most of the documents in the Docs directory are dated September 2005. 
If you locate a more current document on the web, the document in the Docs directory is 
obsolete.

Software Requirements, SQL Queries, and Integration Views

Do not install the CM SvcDsk Datapipe unless the system running OVPI and the system 
running Service Desk are running the necessary prerequisites. The system running OVPI 
must have OVPI 5.1 with SP2 or higher. The system running Service Desk must have Service 
Desk 4.5 with Service Pack 14 or later. Earlier versions are not tested or supported. If those 
prerequisites are met, your next task is to establish connectivity for SQL queries and install 
integration views.

Establishing SQL Connectivity Between OVPI and Service Desk

The CM SvcDsk Datapipe cannot collect data from Service Desk until OVPI recognizes the 
Service Desk system as a supported database. Follow these steps to add the Service Desk 
system to OVPI’s list of supported databases:

1 Determine which port the Service Desk database is using. The default for Oracle is port 
1521. If port 1521 is not available, contact your Oracle system administrator. Follow these 
steps to determine the port for Service Desk installed on SQL server: 

a From the command line, type: svrnetcn.exe

b The SQL Server Network Utility opens. Under Enabled protocols select TCP/IP.

c Click Properties. The port number appears in the pop-up window.

2 Start Performance Insight and open the Management Console.

CM OVIS Datapipe CM_OVIS_Datapipe.ap
Docs

CM Service Desk Datapipe CM_SvcDsk_Datapipe.ap
ServiceDesk_Integration
Docs

Thresholds Thresholds.ap
Docs

Internet Services Report Pack Internet_Services.ap
Internet_Services_Demo.ap
UPGRADE_Internet_Services_to_20.ap
Docs

Internet Services Datapipe Internet_Services_Datapipe.ap

Common Property Tables CommonPropertyTables.ap
UPGRADE_CommonPropertyTables_to_35.ap
Docs

Package Directories
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3 Click the Systems icon located on the left-hand side of the Management Console.

4 Expand the information under the OVPI system by clicking “+”.

5 Right-click Databases and select Add Database. The Add Database Wizard opens.

6 Click Next.

7 Select Generic Supported Database and click Next. 

8 The Database Connection Information window opens. Add the following information:

• Hostname – Either the hostname or the IP address of the Service Desk server.

• Port – The TCP/IP port number. 

• Description – Use ServiceDesk. Avoid spaces and numbers. The description will be 
used later, in the install sequence. 

• Vendor – Select the database vendor for Service Desk.

• Database Instance – Specify the instance for the database.

• Database Username – Username with access to the Service Desk database.

• Password – Database password.

9 Click Next. 

10 Type a unique, identifying System name. Avoid using spaces or numbers in the name. 
Typing a description is optional.

11 Click Next. The Summary window opens.
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12 Click Finish.

13 In the navigational window under System Information, click the External Reference Databases 
folder.

14 Select Service Desk and click the Test Connection button. You should receive a Connection 
Successful message.

If you wish to collect data from more than one Service Desk application, repeat this procedure 
for each installation.

Installing Views on Service Desk

OVPI collects data from Service Desk by initiating SQL queries against the table structures 
stored in the Service Desk database. Due to the complexity of the Service Desk database, the 
queries sent by OVPI are required to access attributes spread across many tables. To make 
accessing these attributes easier, we created a set of integration views. Follow these steps to 
install the integration views:

1 Request a database username and password with a DBA user role from the Service Desk 
system administrator.

2 Copy the CreateViews.sql file from files below the following directory to your Service Desk 
server command line working area.

Oracle:

/OVPI/packages/CM_SvcDsk_Datapipe/ServiceDesk_Integration/Oracle

SQL Server:

/OVPI/packages/CM_SvcDsk_Datapipe/ServiceDesk_Integration/MS_SQL_Server

3 Using the SQL command line (or the SQL visual tool of your choice), the 
CreateViews.sql file, and the username and password you were provided, install the 
views.

SQL prompt example:

>@<path>/CreateViews.sql

SQL database command prompt example:

>isql –U<user name> –P<password> -i <path>/CreateViews.sql

Oracle database command prompt example:

>sqlplus <user name>/<password> @<path>/CreateViews.sql

If the installation is successful, you will see a series of prompts followed by a sequence of 
numbers.

If you wish to collect data from multiple Service Desk installations, repeat this procedure for 
each installation.If necessary, you can remove views at a later date. To do that, use the 
DropViews.sql file.
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Installing the CM Service Desk Datapipe

If packages have not been extracted from the Compliance Manager CD, insert the CD in the 
CD-ROM drive on your system and follow the on-screen instructions for extracting packages 
to the Packages directory on your system. When the extract step is complete, your next step is 
to install the Compliance Manager Report Pack. For details, refer to the Compliance Manager 
Report Pack 1.0 User Guide. 

Once the prerequisite packages are installed, follow these steps to install the CM Service 
Desk Datapipe:

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows NT: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 From the Management Console, start Package Manager. The Package Manager welcome 
window opens.

4 Click Next. The Package Location window opens.

5 Click Install. Approve the default destination directory or browse to a different directory if 
necessary.

6 Click Next. The Report Deployment window opens. Type your OVPI username and 
password.

7 Click Next. The Package Selection window opens. Click the check box for:

CM SvcDsk Datapipe 1.0

8 Click Next. The Type Discovery window opens. Disable the default to run Type Discovery.

9 Click Next. The Selection Summary window opens.

10 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package installation complete message appears.

11 Click Done.

12 Restart OVPI Timer.

Windows NT: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

The CM Service Desk Datapipe is now installed. 
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Confirming Data Collection Readiness

The CM Service Desk Datapipe can begin collecting data when these conditions are met:

• The Service Desk system is recognized as an external database

• The integration views are installed

• The CM Service Desk Datapipe is installed

The first collection will take place tomorrow morning at 4.00 a.m. However, instead of waiting 
until tomorrow to verify that data collection worked as expected, there are a few checks you 
perform right now, as follows:

1 Open this process file: 

/OVPI/packages/CM_SvcDsk_Datapipe/CM_SvcDsk_Datapipe.ap/CM_Svc_Dsk_Retrieve_Data.pro

2 Locate the calls to trend_export.

3 Verify that the value for the -S parameter is the same as the Description you specified when 
you added Service Desk as an external reference database. 

4 If you intend to collect data from more than one Service Desk installation:

• Replicate the incidents section and the changes section.

• Modify the –S parameter for each server.

5 Verify that Compliance Manager can see the data in Service Desk. Follow these steps:

a Using a web browser, log into the OVPI front end.

b Click the Administration tab in the top right

c Open the User Accounts branch of the tree on the left of the screen.

d Click the Users leaf from the tree on the left.

e Select Add New User.

f Supply a username and password.

g Change the Database selection by selecting the Service Desk database.

h Exit the web browser.

i Start the OVPI Builder client.

j Log in using the username and password you have just created.

k Open the following report files:

/OVPI/packages/CM_ScvDsk_Datapipe/CM_SvcDsk_Datapipe.ap/CM_SD_Incidents.rep

/OVPI/packages/CM_ScvDsk_Datapipe/CM_SvcDsk_Datapipe.ap/CM_SD_Changes.rep

You should see a list of incident details in the first report, and a list of change details in 
the second report, for the previous two days. If there have been no changes or incidents 
registered by Service Desk for the previous two days, the reports will be empty.

l To view incidents and changes for the previous year open the following files:

/OVPI/packages/CM_ScvDsk_Datapipe/CM_SvcDsk_Datapipe.ap/CM_SD_Incidents_Year.rep

/OVPI/packages/CM_ScvDsk_Datapipe/CM_SvcDsk_Datapipe.ap/CM_SD_Changes_Year.rep

The query to generate either report complex. Retrieving such a large volume of 
data could interfere with the operation of Service Desk.
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You should see lists of change and incident details for the previous year. If there have been 
no changes or incidents registered by Service Desk in the previous year, the reports will be 
empty.

Verifying Successful Collection

If the first scheduled collection is successful, you will see:

• Service Desk tests in the Service Desk Data Model Assignment form.

• Service Desk services and CIs in the CM to Service Desk Linkage report

To reach the form, follow this path:

Management Console > Objects > General Tasks 

To reach the report, follow this path:

Management Console > Change View > CM Application > Application > Object Specific Reports 

If the form and the report are still empty after the first scheduled collection, you should verify 
that the following prerequisites are in place:

1 You have a valid username and password for accessing the Service Desk database.

2 The views contained in the ServiceDesk_Integration folder are installed on the Service 
Desk database, and they are accessible in the default tablespace using the username and 
password provided.

3 The Service Desk database is registered as an external reference database in OVPI’s 
System Information window.

4 The Service Desk database uses the username and password you were provided.

5 When you click Test Connection, the response is positive.

6 The descriptive name of the Service Desk database does not contain spaces or digits.

7 The descriptive name matches the –S argument for Incidents and Changes in the 
following process file:

/OVPI/scripts/CM_SvcDsk_Retrieve_Data.pro

Removing the Datapipe and Dropping Views

If necessary, you may uninstall the CM Service Desk Datapipe. Uninstalling the datapipe 
does not affect the Compliance Manager Report Pack. If you remove the datapipe, you should 
also drop the views you installed on Service Desk and delete the username and password 
created for Compliance Manager.

OVPI Procedure for Uninstalling the Datapipe

Follow these steps to uninstall the CM SvcDsk Datapipe:

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.
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Windows NT: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 From the Management Console, start Package Manager. The Package Manager welcome 
window opens.

4 Follow the on-screen directions for package removal; when prompted, select the CM 
SvcDsk Datapipe for removal. When the uninstall is complete, a package removal 
complete message appears.

5 Click Done.

6 Restart OVPI Timer.

Windows NT: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Service Desk Tasks

Complete the following steps on the Service Desk system:

1 Using the username and password created for Compliance Manager, run the 
DropViews.sql script.

2 If the username and password created for Compliance Manager have no other use, remove 
them from the Service Desk database.
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3 Datapipe Configuration
This chapter covers the following topics:

• Your Compliance Manager data model structure

• Service Desk data structures

• Using the from to assign Service Desk data structures to CM components

Your Compliance Manager Data Model Structure

Before installing the Compliance Manager Report Pack, a solutions architect must evaluate 
the applications you are running. Part of that evaluation process entails deciding which 
applications are relevant to compliance reporting. Once those relevant applications are 
identified, the solutions architect should help you define business processes and the 
enterprise-wide applications that support those processes. In addition, the solutions architect 
should identify application instances, component groups, components, and the Service Desk 
data structures that target those components. Here is an example of a simple data model:

In this example, the SAP application supports two business processes, Accounts Receivable 
and Accounts Payable. There is only once instance of SAP and it is located in the Americas 
region. SAP is running in failover mode. Although the instance appears to be a single 
installation, there are actually primary and secondary copies of the software deployed on 
separate hardware platforms.

Structure Data Model

Business Processes Accounts Receivable                             Accounts Payable

Applications                                                    SAP

Application Instances                                                 Americas

Component Groups SAP Application Software                             Hardware Devices

Components All SAP Applications Primary Server                    Secondary Server
  15



Service Desk Data Structures

Service Desk manages the processes that define, negotiate, document, and manage the 
services that are delivered to the people who are using the IT infrastructure. The tools 
provided by Service Desk ensure that users have cost-effective access to services. A service 
can be free standing, or it can rely on other services. In addition, a service can be linked to one 
or more configuration items (CIs). A configuration item represents an object (hardware or 
software) in your IT infrastructure. If you add together all of your CIs, you have an accurate 
representation of the environment for your IT support organization and possibly the 
environment for your customers as well.

Changes and Incidents

The integration views you installed on your Service Desk system list changes and incidents 
and associate each change or incident with a parent service or configuration item. A change 
is a detailed description of modifications applied to the managed IT infrastructure or to 
anything necessary for delivering the service. Except for the service and the service level 
agreement, anything related to delivering the service in the IT infrastructure can be changed. 
An incident is an operational event which is not part of the standard operation of the system. 
Incident management is the process of documenting, monitoring, and resolving incidents to 
restore normal system operation. The term system is broad, includes everything related to 
supplying an IT service. The system includes intangibles, such the knowledge a specialist 
possesses, as well as tangible hardware.

Service Desk Data Model Assignment Form

You can see the service and CI tree structure in Service Desk reflected in the Service Desk 
Data Model Assignment form, shown on the next page. This form provides a compressed view 
of services and configuration items. The form’s view of Service Desk compresses four Service 
layers and up to three Configuration Item layers. Each line in the selection table represents a 
piece of the Service Desk model. Your task now is to assign each piece of the Service Desk 
model to a component in the Compliance Manager data model. Once the Service Desk data 
structure is assigned, incident and change data for that component will be transferred on a 
daily basis from Service Desk table structures to Compliance Manager table structures.

Assigning SD Data Structures to CM Components

Follow these steps to assign Service Desk data structures to components in your Compliance 
Manager data model:

1 Open the Service Desk Model Assignment form.

2 If necessary, use the filter boxes to shorten the length of the list. 

A red circle in the last column indicates that the data structure has not been assigned to a 
component; a green circle indicates that the data structure is already assigned. 

3 Highlight a Service Desk data structure in the selection table.

4 Use the four drop down lists at the bottom of the form to select the component associated 
with the Service Desk item highlighted in the selection table.

5 Click Apply. The red circle turns green. 
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The Service Desk item highlighted in the selection table is now assigned to the component 
you selected at the bottom of the form. The assignment status indicator for that data 
structure is now green and the component you just assigned is no longer visible in the 
drop downs. 

6 Repeat steps 3 through 5 until every Service Desk data structure is assigned to a 
component. 

You are finished with the Service Desk Data Model Assignment form when all of the 
assignment status dots in the selection table are green. 
Datapipe Configuration 17
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4 Extending the Datapipe
This chapter covers the following topics:

• Adding a new metric to the CM Service Desk Datapipe

• Data flow (from datapipe tables to report pack tables)

Adding a New Metric to the Datapipe

You may want to collect a change or incident metric that is not collected by the CM Service 
Desk Datapipe. Extending the datapipe’s collection routines is not difficult, however, you have 
to know SQL and you have to know OVPI. If you know SQL and OVPI well enough, follow 
these steps to add a new metric/attribute to the CM Service Desk Datapipe:

1 Add the new attribute to the views installed on Service Desk. Adding the new attribute 
involves modifying, dropping, and recreating Compliance Manager Change views or 
Incident views.

2 Start Builder. Log in as the OVPI user that was created when the default database was 
set to Service Desk.

3 Navigate to the following directory: OVPI/lib

4 Open one of the following “rep” files: 

• Changes in the last two days

• Incidents in the last two days

• Changes over the last year

• Incidents over the last year

The OVPI/lib directory holds working copies; the original rep files are stored here:

OVPI/packages/CM_SvcDsk_Datapipe/CM_SvcDsk_Datapipe.ap 

5 Repeat the following steps for each rep file:

a Refresh the statistics.

b Copy the new statistic into the on-screen table and notice which column holds the new 
statistic. The new statistic will appear in the column on the far right. Since the first 
five columns are reserved for key fields, do not copy the new statistic into the first five 
columns. 

c Save the file. 

6 If the new statistic must be preprocessed before collection, enable that transformation by 
modifying the perl preprocessor (CM_SD_proprocessor.pl).
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7 Open the appropriate teel file:

RCM_Incidents_SvcDsk.teel

RCM_Changes_SvcDsk.teel

8 Edit the file by adding the new column to the import table. Make sure you add directives 
for create as well as import. The new column must appear in the same position as it 
appears in the report.

9 Using datapipe_manager, recreate the table with the new column. Change the structure 
of the database table itself and change the ImportData statements at the bottom of the 
teel file.

10 If the new column is to be used for statistics on closed or modified incidents, add the new 
column to the applicable teel and sql view files. There are four files in total:

RV_CM_Incidents_by_Mod.teel

RV_CM_Incidents_by_Mod.sql

RV_CM_Changes_by_Mod.teel

RV_CM_Changes_by_Mod.sql

These files are used once at installation time. Along with other original files, they are kept 
in this directory:

OVPI/packages/CM_SvcDsk_Datapipe/CM_SvcDsk_Datapipe.ap 

11 Modify the appropriate summary file:

• SD_CM_Incidents_by_Create.sum [statistics for Incidents that were created]

• SD_CM_Incidents_by_Mod.sum [statistics for Incidents that were modified]

• SD_CM_Changes_by_Create.sum [statistics for Changes that were created]

• SD_CM_Changes_by_Mod.sum [statistics for Changes that were modified]

Working copies of summary files are stored in OVPI/scripts; the originals are kept in 
this directory:

OVPI/packages/CM_SvcDsk_Datapipe/CM_SvcDsk_Datapipe.ap

12 Using the -z option for trend_sum, recreate the summary stored procedures.

13 Add the new column to the destination table in the following files:

SD_CM_Incidents_by_Create.teel

SD_CM_Incidents_by_Mod.teel

SD_CM_Changes_by_Create.teel

SD_CM_Changes_by_Mod.teel

These files are used once at installation time. Along with other original files, they are kept 
in this directory:

OVPI/packages/CM_SvcDsk_Datapipe/CM_SvcDsk_Datapipe.ap 

14 Modify the table structure within the OVPI database by running datapipe_manager for 
each file. Do not drop and recreate tables that store day; instead, use datapipe_manager 
to extend the tables. 
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15 Adjust the combined view, SDV_CM_Incidents (teel and sql), or SDV_CM_Changes (teel 
and sql), so that the combined view holds the new column. Views can be dropped and 
recreated with no loss of data. The teel and sql files are used once at installation time. 
Along with other original files, they are kept in this directory:

OVPI/packages/CM_SvcDsk_Datapipe/CM_SvcDsk_Datapipe.ap

16 Modify the following script:

install_CM_SD_map_p.sql 

This script creates the mapping procedure. Ensure that the new column is carried from 
the datapipe tables to the report pack tables in the same way as the existing data. 

Once the data is carried to the report pack tables, it must undergo processing by various 
summarization and aggregation routines. Your new metric will not appear in reports until you 
implement those processing routines.

Data Flow

The diagram below shows data flowing from datapipe table structures to the Compliance 
Manager Report Pack. At a high level, these are the steps in the data flow:

1 Data is queried every night from views on Service Desk using trend_export and a series of 
rep files. 

2 The collected data is dropped into a flat files for Incidents and Changes on the local OVPI 
system. 

3 The flat files are processed by a Perl script and then uploaded into two separate rate 
tables. 

4 Summaries run on the rate tables, converting the collected data into daily metrics relating 
to newly created Changes and Incidents. 

5 At the same time, views present the data in the rate tables slightly differently, showing 
the data as metrics for existing or modified Changes and Incidents. 

6 The contents of the modified views are summarized into daily tables. 

7 Using two views, one for Changes and one for Incidents, the data on Modified and Created 
Incidents and Changes are associated together. 

8 A mapping procedure moves data from the daily views into the daily table for Components 
within the report pack’s table structures. 

The mapping procedure takes configuration information from K_Summarized_SvcDsk, a 
datapipe property table. Some of the configuration information in that table comes from 
assigning data structures to the Compliance Manager data model using the Service Desk 
Data Model Assignment Form.
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